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Sun, 05/26/2013 - 09:41 #1 Export Multiple Files From IDEA into Excel Hi There I am looking for a custom function / script that will allow me to export multiple IDEA databases into excel without exporting each one individually. I am using IDEA 8.5. Thank you in advance! Aveen Page 2 t t on 6/5/2018 12:44:23 AM there should be some easy way to
export the data into an excel spreadsheet Take the example where in a column you have in each cell the word “invoice” (text) + invoice number (digits). In Excel, I would replace the word invoice with “” to remove the word invoice and keep the invoice number. How do I make an exact copy of a specific column in IDEA 10 and how do I delete a certain
word in every cell of a specific column? - Mike A: You can do this easily with IDEA. I am using the Sample-Employees file in the Samples project folder for this demo. In the address field you have the following information: Suppose you want to remove Street from the ADDRESS field. First, go to the field manipulation dialog to append a field. The
easiest way to access it is to double-click on the database and the Field Manipulation dialog pops up. Select Append to add a field and call it ADDRESS NEW and select Virtual Character with a length of 31. You have a choice of field types. Virtual Character is like an Excel field in that you can go back and change an equation you create. If you select a
character field, it cannot be changed once you create the field. So your selection depends on your goals. If you think you might change it in the future, then select the virtual character. Else, you can use the character field. Now we must create the equation for the contents of the field. Click in the Parameter box to open the Equation Editor. For this
equation I will use two the @Replace and the @Upper IDEA functions. I use the @Upper as I don’t know if I will find Street or street or sTreet-using the @Upper changes it all to STREET. @Replace tells IDEA to replace STREET with nothing. Here is what the equation would look like in the equation editor: Once you enter the equation, hit the green
check mark and then the OK button on the Field Manipulation. The results will look like this: - Brian Element, CPA, CIDA, CISE, CFE - IDEA Certified Instructor and Financial Advisor at Public Works and Government Services Canada A: Another way to address Mike’s scenario where text/characters need to be removed is to use the @JustNumbers
function. In Brian’s example, you would Append a numeric field and use the formula @Justnumbers(ADDRESS). A word of caution: if the address does not contain a numeric component, the formula will return the numeric zero. - Sunder Gee, CPA, CMA, CIDA - IDEA Certified Instructor and Senior Director, Data Services at RTA Corporation For more
IDEA tech tips or to ask your own IDEA questions, visit IDEAScripting.com. Many-a-times a need arises to convert PDF Files to other formats, especially Excel spreadsheets. As we all know, it quite tricky to edit, convert, transform, transfer PDF Documents and thus, we are constantly on a lookout for some tool/software that convert a PDF File to
Excel as and when required. In this article, we will not only introduce to our readers a great and easy way to transform PDF to Excel and other file formats, but also provide a detailed guideline about how to do so. Stay tuned to know all about the easiest way to transfer PDF to Excel with PDFelement ProPDFelement Pro . The Best Tool to Transform
PDF to Excel PDFelement Pro is a multi-function PDF Editor tool. It can help you to transform PDF in Excel and other high quality output file formats within seconds and also allows you to convert multiple PDF files in batch. How to Transform PDF to Excel In this segment we will put PDFelement Pro for Mac to use. Given below is a guide to assist you
in using this PDF to Excel converter. Follow these instructions carefully to transform your PDF File to Excel on your Mac easily: Step 1. Download and install the program First and foremost, visit the PDFelement Pro website and download the product on your Mac. Launch the program and you will see 6 different tabs before you. Each tab is a
different toolkit and performs a specific function related to PDF Files. Step 2. Import the PDF Once you click on "Convert PDF", you can browse your Mac to select the PDF Document which needs to be converted to Excel. When the PDF File displays before you, move on to the next step. Step 3. Transform PDF to Excel Next up, visit the "Convert"
section to see a list of out format options before you. Herein, click on "To Excel". You may also navigate to the right side of the screen where you can hit "Options" and set the range of the page and just other settings. Once you are satisfied with all the changes you have made, hit "Convert" and PDF File conversion will begin automatically. There's a
way to transform multiple PDF Documents to Excel simultaneously. It's called the "Batch Process" feature of PDFelement Pro. To use this toolkit, click on "Back Process" on the Mia interface followed by "Convert" and finally clicking on "Add Files" to import all the PDF Files to the software. Then just select "Excel" and hit "Convert" to transform all
your PDFs at once. Except transforming PDF to Excel, you can also extract data from PDF files to Excel. Bottomline, we recommend that you use PDFelement Pro for all your PDF related work as it is highly efficient and effective. Why Choose PDFelement Pro to Transform PDF to Excel PDFelement ProPDFelement Pro is a 100% clean software which
prevents data loss. It offers free customer support to its users and send annual product updates with exciting new features and toolkits. With the help of this PDF converter you are not only allow to convert PDF to Excel and other file formats, but also edit PDF images, texts and other elements. Advanced OCR feature also allows you to edit and
convert scanned PDF files with ease. Some of PDFelement Pro features are listed below: It can convert, create, split and merge PDF File texts, images, pages. It can concert PDF Files to Excel, Word, ePUB, PPT, HTML, RTF, images and more formats. Its OCR technology can enable scanned PDF editing and conversion as well. Highlighting, marking
up, signing, stamping, bates numbering and indexing is also possible with this tool to customise and organise PDF Files. It can password protect PDF Files for secure sharing. Excel Ideas helps you extract the key information from a spreadsheet, but there's currently a limited range of insights available and some data formatting may be required. Excel
offers many ways to visualise your data -- charts, conditional formatting, sparklines, PivotCharts and more. However, some of these features are fairly complex to use and it can take time to find the right visualisation to show the trends, outliers and other useful information in your data. The new Ideas button in the Office 365 subscription versions of
Excel will actually make the visualisations and charts for you, and show trends and outliers in your data.In theory, all you have to do is select one or more cells and then click the Ideas button on the Home tab of the ribbon. You'll then see a task pane with all the suggested charts for trends, outliers, correlations and PivotCharts for what's interesting
in your data, with the chart type automatically chosen and the axes, labels and titles all filled in.These are some of the basic features from Power BI -- they use the same Al, but because your Excel spreadsheet probably doesn't have a complex data model defined, which most Power BI data sources do, the results won't be as in-depth. But just seeing
which pieces of data don't fit with the rest can help you to quickly spot anything unusually good or worryingly bad. It's particularly useful if you need to look at a data set that you didn't put together yourself: Ideas is a fast way to get the important highlights. You have to turn on Intelligent Services before Excel Ideas will work. In practice, getting
Ideas to be useful takes a little more preparation, and what you get out of it depends on the data you have to start with. For a start, to get useful labels you need to format your data as a table with a single header row at the top, using the terms you want to see on the charts. Select your data and press Ctrl-T or pick a table style from the Format as
Table dropdown in the ribbon. If the table doesn't cover all the rows or columns you want to include, click Resize Table on the ribbon's Design tab and either type in the furthest row and column letter and number, or drag to make a new selection before clicking OK. If there isn't already a row with headers, type them into the top of each column --
don't reuse header names or leave blanks, and stick to a single header for each column, without any merged cells or double rows of headers. It's better to use a separate sheet to layout a copy of your data if you need to format it as a report with fancier headers, but you can also right-click a cell and choose 'Format cells...' and then choose the
Alignment tab and set Horizontal to Center Across Selection. SEE: Software Usage Policy (Tech Pro Research)If you need to merge tables, set up nested data or create a more complicated layout, use the Get & Transform tools (what used to be called Power Query): on the Data tab choose Get Data / Combine Queries and either Merge or Append. That
way the layout of the data becomes part of the data model that Excel Ideas can use rather than just being text on the spreadsheet.The more categories you have in the table, the more ways Excel has to group the data and look for patterns, trends and correlations. So if your data has a fairly flat organisation, add some extra columns that you can use
for topics and categories.Format your data so Ideas can understand it and you will see multiple suggestions for what matters in the data.The file needs to be saved as an XLSX file (or XLSM if it has macros in); Ideas won't work on the older XLS binary file format, so if the icon is greyed out on the ribbon, check the file format. You also need to make
sure your data set isn't too large; Ideas can only work with up to 16MB of data (that's about 250,000 cells). If your data is larger than that, click the dropdown arrow for each header and use Excel's filters to trim it down; (if it's arranged by date, take the most recent years or filter out any really small figures) and make a copy to run Ideas over.You
also need to check that cells are formatted correctly; if you have cells with text in that are formatted as dates, it tends to confuse Ideas. And if you have dates that are written out as text and not formatted as dates, Ideas won't know they're dates; select them and set the cell format to date. Excel will warn you about dates with only two numbers for the
year; click on the warning icon and convert them to show the full four digits.Before you can use Excel Ideas or any of the other recent Al-powered tools in Office like Word Editor or Outlook Focused Inbox, you'll need to turn on Intelligent Services (even if you've been using previous versions of these, you may need to turn this setting on again because
it uses the content in your documents to make suggestions). You'll see a popup when you choose Ideas from the ribbon, or you can choose File / Options and tick 'Enable services' under 'Office intelligent services'.Smarter than a wizardInitially, Ideas only finds a handful of different classes of insights. Trends are increases, decreases or repeating
patterns in the data, like seasonal results. Rank picks out sets of figures that are noticeably higher than the rest and Majority finds the categories that make up most of a total value. Outliers are unusually good or bad results in data organised by time or correlated with other data. Depending on your data, you might get multiple results for some
insights; Ideas may also suggest useful groupings for organising your data.Often there will be more suggestions than fit on-screen and the more useful ones can be hidden, so it's worth clicking through to show them all. The Ideas pane isn't dynamic either; if you edit your data or select a different table to get insights on, you have to click the Ideas
button to generate new suggestions. That does let you leave the charts in the task pane while you look through underlying figures that might explain what you're seeing. Click the Insert button on a suggestion to place the chart or PivotChart on the spreadsheet so you can dig into it in more detail. For a PivotChart, this creates a new spreadsheet tab
showing the filtered data the PivotChart is based on, and opens the PivotChart Fields task pane so you can experiment with adding more fields to see what else you can learn about the data.Having Excel create PivotCharts automatically is a huge time saver.Oddly, charts don't use any colour themes that applies to your spreadsheet (sticking instead to
a fairly accessible but simple palette that clearly highlights the single significant value), but PivotTables do pick up your theme settings. Far more annoying, all dates on charts are set to US format with MM/DD/YYYY; you can change that, but it should be picked up from the date format used in your table.The chart titles are clear and descriptive, and
the charts follow good data visualisation practices like showing data labels horizontally so they're easy to read and sorting bars in descending order so you can clearly see the full pattern even when you can't spot the exact value. Ideas is far more useful than the Recommended Charts tool tip because instead of charting all the data in your table it
picks out just the data series that tell an interesting story. That's handy for charts, but it's phenomenally useful for PivotCharts, unlocking a very powerful feature that many users find off-putting -- Recommended Charts can only make blank PivotCharts, leaving you to do all the hard work of putting the right data series in the right place. Even with the
limited number of insights currently available and the formatting you might have to do to make your data suitable for Excel Ideas, it's an excellent way of quickly getting the important information out of a spreadsheet. It's also a gentle introduction to some of the more powerful features in Excel. There's no better way of understanding how tools work
than by seeing them used in action on your own data.See also 1 Open Microsoft Excel on your computer. The Excel icon looks like a white "X" in a green square, and a spreadsheet icon in the background. You can find it on your Start menu on Windows or in your Applications folder on Mac. 2 Click the Data tab on the toolbar. You can find this tab
above the toolbar ribbon at the top of your spreadsheet. 3 Click From Text on the toolbar ribbon. This button looks like a blank sheet icon with a tiny text document in front of it. You can find it on the Data toolbar. This will open your file navigator, and allow you to select the text file you want to import. 4 Select the text file you want to import. Click on
the text file you want to convert to Excel, and click the Get Data or Open button in the file navigator pop-up. This will open the Text Import Wizard in a new pop-up window. 5 Select Delimited in the Text Import window. You can find it at the top of the Text Wizard pop-up. Most text files contain delimited data. This means your data entries are
separated by tabs, commas, or a different character, rather than fixed-width spaces with columns. If the data in your text file is separated into columns with fixed-width spaces in between, you can select Fixed width here. You can see a preview of your text import at the bottom of the import window. 6 Click Next in the Text Import window. This will
take you to the next step. 7 Uncheck the Tab option. You can find it under the "Delimiters" heading in the upper-left corner of the Text Import window. If this option is checked, the Import Wizard will automatically detect the spaces in your text as tabs, and separate it into columns. 8 Check the Comma option. This option is also under the "Delimiters"
heading on the top-left. Optionally, you can also leave this option unchecked if you don't want to separate any of the data entries in your text. For example, if you're importing a list, you can leave all the delimiters unchecked here. 9 Click Next in the Text Import. This will take you to the final step. 10 Click Finish. This will import all the text in your text
file to the spreadsheet. If you're prompted to select a column for your import, select the cell where you want your imported text to start on the spreadsheet, and click OK. 11 Click the File tab. This button is in the upper-left corner of your screen. It will open a drop-down menu. 12 Click Save As on the "File" menu. This will allow you to save your
imported text as an Excel spreadsheet file. 13 Select a location to save your file. Click a folder in the "Save As" window to save your new spreadsheet file. 14 Click Save. This will save your imported text to the selected folder as an Excel file.
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